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About this lab 

This lab provides an in-depth look at the Integrated Drive Add-On Profiles included with RSLogix 5000 

v16 (or higher). 

Also shown, is a lab section that provides a sneak preview of the new PowerFlex Accelerator Toolkit Add-

On Instructions and Faceplates.  All of the toolkit materials (including the Quick Start Guide) are available 

for download from the following link: 

http://www.rockwellautomation.com/solutions/integratedarchitecture/resources5.html 

 

 

This lab takes approximately ~100 minutes to complete.  Additional optional materials are provided for 

those that finish early. 



 

5 of 108 

About Integrated Drive Profiles and Premier Integration 

Integrated Drive Profiles were designed to save system development time and to make systems easier to 

maintain. 

Integrated Drive Profiles in RSLogix 5000 v16 (or higher) can reduce drive system development time by 

as much as 70% (figure obtained from timed side-by-side drive configuration comparison testing) by: 

• Providing one software tool to configure the entire Logix / drive system. 

• Configuring both controller and drive network connections from a single location - eliminating 
I/O mismatch errors. 

• Allowing the dynamic selection of drive parameters transmitted as network I/O – 
communicating only what is needed for the application. 

• Auto-generating descriptive tag names - eliminating the need to enter individual tag 
descriptions. 

• Auto-generating respective tag data types - eliminating the need to convert from one data 
type to another. 

• Saving all drive configurations in the RSLogix project file and in the Logix controller – 
providing a single source of drive configuration data. 

• Providing Copy & Paste capability when creating additional duplicate drives – also duplicates 
the drive configuration settings so all the new drive needs is a different node address. 

• Allowing use of the same easy-to-use drive configuration Wizards used in DriveTools SP and 
DriveExplorer. 

Systems using the Integrated Drive Profiles in RSLogix 5000 v16 (or higher) are also easier to maintain: 

• Drive diagnostic, fault, alarm and event information is integral to RSLogix 5000. 

• Drive Tech Support Wizard can be run from RSLogix 5000 to collect all pertinent information 
about a drive, it's peripherals, various software components, and PC operating system. 

• Drives can be flash updated from RSLogix 5000. 

Having a single repository of drive configuration data (in RSLogix project file) speeds drive replacement. 

Integrated Drive Profiles are "Add-On" Profiles, meaning new profiles can be introduced at any time (not 

tied to a specific RSLogix 5000 release) and utilized by v16 and higher versions of RSLogix 5000. 
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Tools & Prerequisites 

Here is a list of hardware and software you will need to perform this lab. 

 

� PowerFlex 700 VC (v4.010) demo with a 20-COMM-E EtherNet/IP adapter (v3.003) 

� ControlLogix demo with: 

- 1756-L63 controller (v17) in slot 2 

- 1756-ENBT EtherNet/IP bridge module (v4.6) in slot 0 

- Ethernet switch 

� Computer installed with: 

- Windows XP SP2 OS 

- RSLogix 5000 v17 (or higher) with Integrated Drive Profiles 

- RSLinx 2.54 (or higher) 

- FactoryTalk View Studio v5.00 (or higher) 

- Internet Explorer v6 (or higher) 
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Document Conventions 

Throughout this workbook, we have used the following conventions to help guide you through the lab 

materials. 

 

This style or symbol: Indicates: 

!
 

ATTENTION: Identifies information about practices or 
circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you: 

• identify a hazard 

• avoid the hazard  

• recognize the consequences 

Words shown in bold (e.g., 
RSLogix 5000 or OK) 

Any item or button that you must click on, or a menu name from 
which you must choose an option or command.  This will be an 
actual name of an item that you see on your screen or in an 
example. 

Words shown in bold italics, 
enclosed in single quotes (e.g., 
'Controller1') 

An item that you must type in the specified field.  This is information 
that you must supply based on your application (e.g., a variable). 

Note:  When you type the text in the field, remember that you do 
not need to type the quotes; simply type the words that are 
contained within them (e.g., Controller1). 

 

The text that appears inside of this gray box is supplemental 
information regarding the lab materials, but not information that is 
required reading in order for you to complete the lab exercises.  
The text that follows this symbol may provide you with helpful hints 
that can make it easier for you to use this product.  Most often, 
authors use this “Tip Text” style for important information they want 
their students to see. 

Note:  If the mouse button is not specified in the text, you should click on the left mouse button. 
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Connecting and Energizing the Demo 

!
 

ATTENTION: Hazardous voltages exist beneath the 
product covers. Contact with circuits under the cover 
can result in death or serious injury by electric shock. 
Do NOT remove the product covers.    

1. De-energize the drive and ControlLogix demos. 

2. Verify the 20-COMM-E module has been properly installed into the PowerFlex 700VC 

(inside the front cover of the drive) and the IP Address has been set.  If the 20-COMM-E 

module has not been installed or the IP Address not been set, PLEASE CONTACT AN 

INSTRUCTOR FOR HELP BEFORE PROCEEDING WITH THE LAB. 

3. Connect the computer to the Ethernet switch in the ControlLogix demo. 

4. Connect the 20-COMM-E EtherNet/IP adapter on the drive to the Ethernet switch in the 

ControlLogix demo. 

5. Connect the 1756-ENBT EtherNet/IP Bridge in the ControlLogix chassis to the Ethernet switch. 

6. Make sure the controller resides in slot 2 and the EtherNet/IP Bridge resides in slot 0 of the 

ControlLogix chassis. 
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7. Prepare the control switches on the drive demo. 

 

Position the IMC Motor Select switch to the 700 position.  This position connects the motor to the 

PowerFlex 700 VC.           

             

 

 

8. Energize the PanelView demo box by putting the 120V ac switch, located on the lower right-hand, 
in the on (1) position. In addition, verify that the circuit breaker is in the on (left) position. 
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9. Energize the Motor Control demo box by putting the 120V ac switch, located on the lower left-

hand, in the on (1) position. In addition, verify that the circuit breaker is in the on (left) position. 
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Creating an RSLogix 5000 project with a PowerFlex Integrated Drive 

Profile 

1. Start the program. 

 

Double-click the RSLogix 5000 icon on the desktop, or from the Start menu, select  

All Programs > Rockwell Software > RSLogix 5000 Enterprise Series > RSLogix 5000. 

2. Create a new project. 

 

Select File > New. 

 

Enter the controller type found in slot 2 of your ControlLogix demo (e.g., 1756-L63), and enter all 

other data as shown below.  Click OK. 

 

 

 

A screen may appear that says the file name already exists on the computer.  If you are using the 

same name as shown in this example, click Yes to overwrite the file. 

 

Integrated Drive Profiles are available for almost every drive, and are included with 
version 16 (or higher) of RSLogix 5000 software. 
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3. Add a new module to the system. 

 

Right-click on the 1756 backplane under the I/O configuration folder and select New Module. 

 

 

 

This opens the Select Module window, which lists the available modules for the 1756 backplane. 
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4. Add the Ethernet Bridge to the system. 

 

Expand the Communications section, scroll down and select the 1756-ENBT/A, and click OK. 

 

 

 

5. Select the ENBT’s revision.  

 

Select 4 for the Major Revision and click OK. 
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6. Enter the ENBT’s information.  

 

Enter the ENBT data as shown below. 

 

 

 

If the Open Module Properties box is checked, uncheck it and then click OK to close the New 

Module screen. 

 

7. Verify the ENBT is in the I/O configuration folder.  

 

The ENBT should now show up under the 1756 backplane in the I/O Configuration folder.  
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8. Add a new module to the system.  

 

Right-click on the 1756-ENBT under the I/O configuration folder and select New Module. 

 

 

 

This opens the Select Module window, which lists the available modules for the ENBT. 
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9. Add a PowerFlex 700 Vector-200V-E drive to the system.  

 

Expand the Drives section, scroll down and view the new Integrated Drive Profiles that are 

available now in v16.  Several drives that had to use the Generic profile will now have profiles, 

such as PowerFlex 4-Class drives.  Select the PowerFlex 700 Vector-200V-E and click OK. 

 

 

 

Note: Make sure you select the PowerFlex 700 VECTOR-200V-E and not the PowerFlex 
700-200V-E. 
 

THESE ARE DIFFERENT DRIVES. 
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10. Enter the PowerFlex 700 VC node information.  

 

Enter the PowerFlex 700 VC data for Name and IP Address as shown below. 

 

 

 

Now click Change in the Module Definition section to edit the I/O connection information. 
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11. The “Module Definition” screen will appear. 

 

 

 

Set the drive’s major revision to 4, minor revision to 10. 

Set the Drive Rating to 240V 2.2A. 

Do NOT click OK. 

 

Up to 10 words of Input Data and 10 words of Output Data can be defined for the 
connection.  By default, drive status and control information will be communicated.   
 
Status Information 
The “DriveStatus” word contains the Logic Status bit information, such as Ready, Alarm, 
Fault, and At Reference. The “OutputFreq” word contains the Feedback information, 
which shows the actual operating frequency of the drive. 
 
Control Information 
The “DriveLogicRslt” word contains the Logic Command bit information, such as Stop, 
Start, Forward, Reverse, and Reset.  The “CommandedFreq” word contains the 
commanded Reference for the drive to run. 
 
Datalinks A, B, C, D 
Datalinks are pointers to drive parameters.  Instead of offering fixed I/O assemblies 
where what-you-see-is-what-you-get, our drive I/O assembly is dynamic and gives the 
programmer the ability to pick & choose the desired drive parameters to communicate as 
network I/O.  
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12. Enable the Datalink A input data.  

 

Check the Datalink A box to enable Datalink A information to be communicated as network I/O.  

 

Do NOT click OK. 

 

 

 

Enabling a Datalink allows up to (2) 32-bit parameters to be read and (2) 32-bit parameters to be 

written via the network I/O. 

 

Checking Datalink A also automatically sets the following parameters for the 20-COMM-E 

EtherNet/IP adapter:  

• Parameter 23 [DPI I/O Cfg] – turns on the Datalink A bit so the 20-COMM-E will communicate 
Datalink A information with the drive.  

• Parameter 35 [M-S Input] – turns on the Datalink A bit so the 20-COMM-E will input Datalink 
A information from the controller.  

• Parameter 36 [M-S Output] – turns on the Datalink A bit so the 20-COMM-E will output 
Datalink A information to the controller. 
 

This highlights one of the benefits of the PowerFlex Integrated Drive Profile: ease-of-use.  
In this example, a simple check-box eliminated the need for the user to edit three 
different parameters and turn on a specific bit in each. 



 

20 of 108 

13. Configure the input data from Datalink A.  

 

Click the Undefined_A1 drop-down arrow in the Input Data column to view the PowerFlex 

parameters.  Select AccelTime1. 

 

Click the Undefined_A2 drop-down arrow in the Input Data column to view the PowerFlex 

parameters.  You can scroll down to the DecelTime1 parameter to select it, or you can start 

typing “de” in the box to display parameters starting with those characters.  Use either method to 

enter DecelTime1 for Datalink A2. 

 

Do NOT click OK. 

 

 

 

Entering the Input Data for Datalink A automatically sets the following parameters for the 

PowerFlex 700 VC: 

• Parameter 310 [Data Out A1] – set to 140 so the PowerFlex 700 VC will communicate 
Parameter 140 [Accel Time 1] as the Datalink A1 information sent to the 20-COMM-E.  

• Parameter 311 [Data Out A2] – set to 142 so the PowerFlex 700 VC will communicate 
Parameter 142 [Decel Time 1] as the Datalink A2 information sent to the 20-COMM-E. 
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14. Configure the output data to Datalink A.  

 

Click the Undefined_A1 drop-down arrow in the Output Data column to view the PowerFlex 

parameters.  Select AccelTime1. 

 

Click the Undefined_A2 drop-down arrow in the Output Data column to view the PowerFlex 

parameters.  You can scroll down to the DecelTime1 parameter to select it, or you can start 

typing “de” in the box to display parameters starting with those characters.  Use either method to 

enter DecelTime1 for Datalink A2. 

 

Do NOT click OK. 

 

 

 

Entering the Output Data for Datalink A automatically sets the following parameters for the 

PowerFlex 700 VC: 

• Parameter 300 [Data In A1] – set to 140 so the PowerFlex 700 VC will take the Datalink A1 
information sent from the 20-COMM-E and write it to Parameter 140 [Accel Time 1].  

• Parameter 301 [Data In A2] – set to 142 so the PowerFlex 700 VC will take the Datalink A2 
information sent from the 20-COMM-E and write it to Parameter 142 [Decel Time 1]. 
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15. Enable the Datalink B input data. 
 
Check the Datalink B box to enable Datalink B information to be communicated as network I/O. 
 
Do NOT click OK. 
 

 
 
Checking Datalink B automatically sets the following parameters for the 20-COMM-E EtherNet/IP 
adapter: 

• Parameter 23 [DPI I/O Cfg] – turns on the Datalink B bit so the 20-COMM-E will communicate 
Datalink B information with the drive 

• Parameter 35 [M-S Input] – turns on the Datalink B bit so the 20-COMM-E will input Datalink 
B information from the controller 

• Parameter 36 [M-S Output] – turns on the Datalink B bit so the 20-COMM-E will output 
Datalink B information to the controller 

In this example, a simple check-box eliminated the need for the user to edit three different 
parameters and turn on a specific bit in each. 
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16. Configure the input data from Datalink B. 

 

Click the Undefined_B1 drop-down arrow in the Input Data column to view the PowerFlex 

parameters.  You can scroll down to the Fault1Code parameter to select it, or you can start 

typing “f” in the box to display parameters starting with those characters.  Use either method to 

enter Fault1Code for Datalink B1. 

 

Click the Undefined_B2 drop-down arrow in the Input Data column to view the PowerFlex 

parameters.  You can scroll down to the DCBusVoltage parameter to select it, or you can start 

typing “dc” in the box to display parameters starting with those characters.  Use either method to 

enter DCBusVoltage for Datalink B2. 

 

 

 

Entering the Input Data for Datalink B automatically sets the following parameters for the 

PowerFlex 700 VC: 

• Parameter 312 [Data Out B1] – set to 243 so the PowerFlex 700 VC will communicate 
Parameter 243 [Fault Code 1] as the Datalink B1 information sent to the 20-COMM-E.  

• Parameter 313 [Data Out B2] – set to 12 so the PowerFlex 700 VC will communicate 
Parameter 12 [DC Bus Voltage] as the Datalink B2 information sent to the 20-COMM-E. 
 



 

24 of 108 

17. Configure the input data from Datalink C. 
 
Check the Datalink C box to enable Datalink C information to be communicated as network I/O. 
 
Click the Undefined_C1 drop-down arrow in the Input Data column to view the PowerFlex 
parameters.  You can scroll down to the OutputCurrent parameter to select it, or you can start 
typing “ou” in the box to display parameters starting with those characters.  Use either method to 
enter OutputCurrent for Datalink C. 
 
Do NOT click OK. 
 

 
 
 
Entering OutputCurrent automatically sets the following parameters for the PowerFlex 700 VC: 
 

• Parameter 314 [Data Out C1] – set to 3 so the PowerFlex 700 VC will communicate 
Parameter 3 [Output Current] as the Datalink C1 information sent to the  
20-COMM-E.  

You may now click OK.  I/O configuration is complete. 
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18. You will come back to the General screen again. 
 
Click OK to close the Module Properties window. 
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19. Verify the PowerFlex 700 Vector is in the I/O configuration folder.  
 
The PowerFlex 700 Vector node has been created and now resides in the I/O tree. 
 

 
 
If your application required multiple duplicate drives, you could right-click on the PowerFlex 700 
VC to copy it and then right-click on the ENBT and paste it as many times as needed.  All node 
information is copied, including the drive parameter settings.  All the user has to do is change the 
IP address, and give the drive a new name.  Integrated Drive Profiles are not only easy-to-use; 
they also allow larger systems to be designed faster. 
 
Where do you think the drive configuration data gets stored? 
 
The drive configuration data for each node is actually stored in your RSLogix 5000 project (the 
.ACD file)!  It also resides in the ControlLogix when the .ACD is downloaded to the controller.  
This provides a convenient local resource for a node’s configuration settings should the node 
need replacing.  Just connect to the controller, open the drive’s AOP and download the 
configuration! 
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20. View the input tags.  

 

Double-click on the Controller Tags under the Controller folder and expand the My_PF700VC:I 

inputs.  It may be necessary to drag the “Name” column right margin in the header to view the full 

input tag names. 

 

 

 

Descriptive tag names have been created for the configured I/O.  The Drive Status bits (BOOLs) 

are clearly defined as well as the Output Frequency and the Datalinks.  Note that the proper data 

types are used for every tag.  Datalink C2 is not used but still needs a tag name assigned, so its 

name includes the word “undefined” to show that they are not used at this time (not linked to a 

parameter). 

This drive, the PF700VC, has 16 bit Logic Status Word (DriveStatus), Logic Command 
Word (DriveLogicRslt), Speed Feedback (OutputFreg), Speed Reference 
(CommandedFreq)  and 32 bit Datalinks (AccelTime1, DecelTime1, etc.).  The PF700 
Standard Control, PF70 Standard Control, and PF70 enhanced control (EC), all have 16 
Bit Logic Command/Status, Reference/Feedback, and Datalinks.  PF700S has 32 bit 
LCW/LSW, Reference/Feedback, and Datalinks. 
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21. Verify the output tags.  

 

Now expand the My_PF700VC:O outputs and scroll down to view the output tag names. 

 

 

 

Descriptive tag names have been created for the configured I/O.  The Drive Logic bits (BOOLs) 

are clearly defined as well as the Commanded Frequency and the Datalinks.  Note that the 

proper data types are used for every tag.  Datalinks B1, B2, C1 & C2 were not used but still need 

tag names assigned, so their names include the word “undefined” to show that they are not used 

at this time (not linked to a parameter). 

 

Close the Controller Tags window by clicking the lower X button in the upper-right corner of the 

screen. 
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22. Open the PowerFlex 700 VC module properties. 

 

Double-click on the PowerFlex 700 Vector node in the I/O Configuration folder to display the 

Module Properties screen.           

 

 

   

Click on the Drive tab. 
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23. View the PowerFlex 700 VC Drive tab.  

 

The Drive tab is new starting with version 16.  Previous versions of RSLogix 5000 included 

DriveExecutive Lite, which could be launched via an icon on a drive’s Module Properties window 

(but, still needed to be installed on the computer).  Instead of having two separate software 

applications, drive configuration software is now fully integrated with RSLogix 5000. 

 

 

 

Many familiar features of DriveExecutive and DriveExplorer are now incorporated in the Drive tab: 

• Menu tree 

• Status View display 

• Icons 

• Wizards 

• Linear List editor 

• File / Group / Parameter editor 

• Alarms and Events 

• Device Properties 

• Diagnostic Items 

 

The Drive tab also has import / export capability so DriveExecutive can continue to be used by 
maintenance or other personnel that may not have the authorization to use RSLogix 5000. 
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24. Setting the 20-COMM-E’s Subnet configuration parameters. 

 

Click the Port Configuration tab, enter the Subnet Mask address as shown, and then click Set.  

 

 

 

This completes the configuration of the IP address.  
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25. View the automatically-set network parameters. 

 

Click the Drive tab again. 

 

Expand the 20-COMM-E in the tree view and double-click on its Device Parameters to view the 

Linear List editor. 

   

 

Scroll down and look at the values for parameters 23, 35 and 36.  As previously mentioned, these 

parameters were automatically set when you were configuring the I/O connection in the 

PowerFlex 700 VC Module Definition window. 

 

 

 

Click Close. 
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26. View the automatically-set Datalink parameters. 

 

Double-click on the Parameter List for the drive.  From the All Parameters pull-down menu, 

expand the Communication folder and then click on Datalinks to display the Datalink parameters. 
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27. Verify the automatically-set Datalink parameters values.  

 

Look at the values for parameters 300, 301, 310, 311, 312, 313, and 314.  As previously 

mentioned, these parameters were automatically set when you were configuring the I/O 

connection in the PowerFlex 700 VC Module Definition window. 

 

 

 

140 refers to Parameter 140 [Accel Time 1]. 

  142 refers to Parameter 142 [Decel Time 1]. 

  243 refers to Parameter 243 [Fault Code 1]. 

  12 refers to Parameter 12 [DC Bus Voltage]. 

  3 refers to Parameter 3 [Output Current]. 

  From the Parameter Group pull-down menu, select “All Parameters” and then set  
Parameter 298 – [DPI Ref Select] to “Max Speed.” 
 
Click Close.  
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28. Launch the PowerFlex 700 VC Startup Wizard: 

 

Click on the Wizard icon  in the toolbar to view the available wizards.  Select the PowerFlex 

700/700VC Startup Wizard and click Select. 

 

 

Note: This window may open behind another window. If you do not see it, look 
for it in the Windows task bar at the bottom of the screen. 

29. View the wizard’s warning dialog.  

 

A Wizard Launch Confirmation dialog box will appear.  The message let’s you know that there 

may be unexpected, hazardous motion of machinery when using this software to configure a 

drive. 

 

 

 

Click Yes to launch the startup wizard.  
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30. Begin Step 1 of the PowerFlex 700 VC Startup Wizard.  

 

The Startup wizard is an easy-to-use tool to quickly configure a drive.  The user does not have to 

know parameter numbers and instead works with descriptive text and graphical representations 

of the configuration.   

 

 
Click Next> to view the sequential process and continue to click Next> until you reach Step 4 of 

the Wizard. 
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31. Perform Step 4 of the PowerFlex 700 VC Startup Wizard.  

 

Set: Motor NP Power 1.00 Hp        

 Motor NP FLA 1.0 Amps 

 

 
Click Next> to continue viewing the sequential process and continue to click Next> until you 

reach Step 9 of the Wizard. 
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32. Perform Step 9 of the PowerFlex 700 VC Startup Wizard.  

 

Enter:   Max Speed 60 Hz         

 Min Speed 0 Hz         

 Enter a non-zero value for the S Curve to see what happens with the graphic.  

 Then reset it back to 0.  

 

 

 

Click Next. 
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33. Perform Step 10 of the PowerFlex 700 VC Startup Wizard.  

 

Click on the Speed Reference drop-down arrow and select DPI Port 5.   

 

Notice how the graphic changes to illustrate where the Reference will come from. 

 

 

 

 Continue to click Next> until you reach Step 12 of the Wizard.  



 

40 of 108 

34. Perform Step 12 of the PowerFlex 700 VC Startup Wizard.  

 

Disable all the digital inputs for this lab exercise, by selecting Not Used for each input.  This will 

prevent wiring in the demo from interfering with this lab exercise. 

 

 

  Continue to click Next> until you reach Step 15 of the Wizard.  
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35. Perform Step 15 of the PowerFlex 700 VC Startup Wizard. 

 

All applied and pending changes are listed. 

 

 

 

Clicking the print icon  at the bottom of the window allows you to print the 
changes. 

Click Finish>> to accept the changes. 

 

Startup wizards provide a quick & easy method to get a drive configured quickly.  Although not 

every parameter is covered in a Startup wizard, the commonly used parameters for most 

applications are covered. 

36. Return to the PowerFlex 700 VC parameter list and change the value of parameter 298 [DPI 

Ref Sel] to a value of 1- Max Speed. 
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37. Downloading the drive configuration. 

 

Everything you’ve doing so far has been done offline.  Now you must take this new configuration 

and transfer it to the online drive. 

 

Click on the Download parameter data icon  in the tool bar to begin the drive download 

process.          

 

      

The Connect To Drive window will appear.  Expand either the Ethernet or Ethernet-IP driver 

(depends which is configured on the computer), find the PowerFlex 700 VC drive icon, and select 

it.  Then click OK. 

 

The Integrated Drive Profile will attempt to connect to and verify the drive and its connected 

peripherals.  This may take approximately 10 seconds. 
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The following screens may appear if the drive you are attempting to connect with 
contains different parameter and I/O configurations than the RSLogix 5000 project. 
 

 
When the screen appears, click Use Project.  The project settings will download to the 
drive.  If the following screen appears, click Yes.      
            
     

    
          

The adapter and drive will perform a reset which may take approximately 60 seconds to 
complete.  When the reset is complete, click Continue which will become available 

(ungrayed). 



 

44 of 108 

38. After this is complete, the Select Devices To Download window will appear.  When this window 

appears, the software is telling you that device property differences (configuration, revision, etc.) 

were found between the offline configuration and the online devices (PF700VC, 20-COMM-E, 

HIM, etc.). 

 

 

 

Click Download to merge these new changes. 

 

A download status box will appear.  A complete download may take approximately 10 seconds.  

After it is complete, the download status box will disappear. 
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39. Finish the drive setup before going online. 

 

Finishing the download will take you back to the Module Properties screen. 

 

 

 

Click OK to close the Module Properties screen. 
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Downloading and Verifying the Network I/O is Operational 

This section shows how to download to the drive and controller, and confirm the network I/O is 

operational. 

1. Downloading the RSLogix 5000 project to the controller. 

 

Click the RSWho icon  (or select Communications > Who Active) and expand node 

192.168.1.7 to view the controller backplane.  Select the controller in slot 02, click Set Project 

Path, and then click Download. 

 

 



 

47 of 108 

2. Confirm the download. 

 

If the controller was in Run mode prior to this step, the following screen will appear.  Click 

Download to download the project to the controller.   Click No to place the controller Remote 

Run. 
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However, if the controller was in Program mode prior to this step, the following screen will appear 

instead.  Again, click Download to download the project to the controller. 
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3. Verify the controller’s status. 

 

The controller should be in Program or Rem Prog mode and the I/O OK indicator should be solid 

green. 

 

 

 

The PowerFlex 700 VC in the I/O Configuration tree should NOT have a yellow triangle next to it.  

A yellow triangle  indicates if a problem exists with the connection. 

 

 

Note:  If you do have a yellow triangle, please power cycle to the PF700VC.  If you 
still have the yellow triangle please contact an instructor. 
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4. Put the controller in Run mode. 

 

Either click on the mode drop-down arrow and select Run Mode or switch the controller key to the 

Run position. 

 

 

 

If prompted to confirm Remote Run, click Yes. 

 

 

 

5. View the controller’s Run status.  

 

The following indicator lights should be green and the controller should be in either Rem Run or 

Run Mode.  The Battery LED may be RED, this signifies the battery is low or missing, for our lab 

this does not matter, do not worry about it. 

 

 

 

Note: Please contact an instructor if an error is shown at this step. 
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6. View the controller’s output tags.  

 

Double-click on the Controller Tags in the Menu Tree and click on the  tab located 

on lower left-hand corner. Expand the PowerFlex 700 VC outputs. 
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7. Control the drive. 

a. Enter values for AccelTime1 and DecelTime1 in the column labeled Value.  Note their 

format is in tenths, so a value of 20 equates to 2.0 seconds. 

b. Enter a value between 0 and 32767 for the CommandedFreq.  This is the Reference in 

engineering units where 32767 is maximum frequency (60 Hz). 

c. Enter a 1 for ClearFault and then set it back to 0.  This will reset any fault in the drive. 

d. Enter a 1 for the Start and then set it back to a 0.  All starts require a rising edge (0 to 1) 

transition. 

 

 

 

If desired, use the HIM to look at Parameter 140 [Accel Time 1] and  

Parameter 142 [Decel Time 1] to verify that the data is being sent by the controller. 



 

53 of 108 

8. View the controller’s input tags. 

 

Expand the controller inputs. 
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9. By default, the Reference on the PowerFlex 700 VC drive is provided in engineering units or 

counts, scaled based on the setting for Parameter 298 [DPI Spd Ref]: 

 

For Parameter 298 [DPI Spd Ref] set to Max Freq (0), the following linear relationship applies: 

Commanded_FreqMaxFreq Spd_RefHz( )
Spd_RefHz

Maximum_FreqHz
32767⋅:=

 

 

For Parameter 298 [DPI Spd Ref] set to Max Speed (1), the following linear relationship applies: 

Commanded_FreqMaxSpd Spd_RefHz( )
Spd_RefHz

Maximum_SpeedHz
32767⋅:=

 

 

By default, Parameter 55 [Maximum Freq] is set to 130Hz and Parameter 82 [Maximum Speed] is 

set to 60Hz.  Both equations have been plotted below: 
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10. The Feedback (…OutputFreq) word has a similar linear relationship to the Reference 

(…CommandedFreq).  By default, Feedback on PowerFlex 700 VC drives is provided in 

engineering units or counts, where 32,767 counts equals Parameter 55 [Maximum Freq] OR 

Parameter 82 [Maximum Speed] and 0 counts equals 0Hz. 

 

The “…CommandedFreq” tag should match the “…OutputFreq” tag. 

 

Please note for the lab, Parameter 298 [DPI Spd Ref] is set to Max Speed (1).  Therefore, 

the scaling is based on 60Hz. 

11. Stop the drive. 

 

Return to the drive output tags. 

 

Enter a 1 for the Stop and then set it back to a 0. 
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You now have a complete system.  All tags are operational!  This 
now concludes operating a drive using the new Integrated Drive 

Profiles feature. 
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Using an FactoryTalk View PowerFlex Faceplate with a PowerFlex AOI 

to Control/Monitor the Drive 

This section shows how to set up and use the new PowerFlex Accelerator Toolkit Faceplates available 

with pre-configured Add-On Instructions (AOI) made specifically for your PowerFlex drive.  These 

faceplates reduce the amount of development time needed to perform drive status and control functions 

from an HMI.  All of the steps including software configuration and ladder logic creation will be covered.  

Follow the examples used in this section. 

A link to the PowerFlex Accelerator Toolkit materials (including the Quick Start Guide) is provided below.  

This material includes a more in-depth look at the faceplates. 

http://www.rockwellautomation.com/solutions/integratedarchitecture/resources5.html 
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Importing a PowerFlex AOI and Going Online 

Due to lab time limitations, the PowerFlex Faceplates and Add-On Instructions have been already 

downloaded from the Internet to a specific folder on the PC. 

1. Go back to the RSLogix 5000 project that was just created in the previous section.  Go Offline 

with the controller (if online with it).  In the controller tree view, right-click on the Add-On 

Instructions folder and select Import Add-On Instruction… to open the Import Add-On 

Instruction window. 
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2. For convenience, the PowerFlex AOI files were placed on the Desktop in a folder named 

“ME_PowerFlex_Faceplate_Files.”  Double-click the folder to open it up.  There will be another 

folder (inside the above folder) also named “ME_PowerFlex_Faceplate_Files.”  Again, double-

click the folder to open it up.  In this lab, you are using a PowerFlex 700 VC drive.  Therefore, 

select the file in this folder named “PFlex_700VC_AOI.L5X” and then click Import. 
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Click OK 

 

3. After the file is imported, it will now display under the Add-On Instructions folder in the project tree 

view. 
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4. Point to the new PFlex_700VC_AOI from the MainRoutine. 

 

In the project tree view, expand the MainProgram folder to display the Program Tags and 

MainRoutine subtasks.  Double-click on the MainRoutine task to display the ladder-rung entry 

window (right side of project window). 

 

Click the Add-On tab on the instruction palette as shown: 

 

 

 

Drag-and-drop the “PFlex 700VC” add-on instruction  on to the new rung. 
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5. Once the instruction is added, you will have to configure it.  Double-click on the ? next to 

PFlex_700VC_AOI and enter My_PF700VC.  Please note that My_PF700VC:I may auto 

populate this field, if so be sure to correct the tagname. 

 

 
After entering the My_PF700VC, highlight the tag, right click and select New “My_PF700VC” to 

create this tag.  

 

 

Note that on the “PFlex_700VC_AOI” field must match the name assigned to the drive in the I/O 

configuration tree (for this example, “My_PF700VC”). 
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6. The New Tag window will appear.  The only thing you need to verify here is that the name is 

assigned “My_PF700VC” and that its Data Type field points to the AOI, which is 

“PFlex_700VC_AOI”.  Note that the Scope field must be assigned to My_Controller.  After 

you verify this, click OK. 

 

 

7. Next select/enter the following values for the remaining fields: 

 

Inp_PowerFlex_700VC   My_PF700VC:I 

Out_PowerFlex_700VC   My_PF700VC:O 

Inp_Scaled_Speed_At_32767  60 

 

The end result must look like the screen below:   

 

 

 



 

63 of 108 

8. Download the new settings to the controller. 

The present path to the controller is already established.  Therefore, you can download the new 

project settings by clicking Communications > Download from the top menu bar. 
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9. If the controller was in Program mode prior to this step, the following screen will appear.  Click 

Download to download the project to the controller.  After downloading, put controller in either 

Rem Run (from software) or Run mode (keyswitch). 

 

 

 

However, if the controller was in Run mode prior to this step, the following screen will appear 

instead.  Again, click Download to download the project to the controller and then click Yes to 

place the controller into the Run mode. 
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Importing a FactoryTalk View ME PowerFlex Faceplate 

1. Launch FactoryTalk View Studio.   

 

Double-click the FactoryTalk View Studio icon on the desktop                   , or from the Start 

menu, select All Programs > Rockwell Software > FactoryTalk View > FactoryTalk View 

Studio. 

2. The Product Type Selection window will appear.  Select the Machine Edition icon and then click 

Continue. 

3. Click the New tab to display the New/Open Machine Edition Application window.  Enter an 

Application name (for example, PF_Faceplate) and then click Create. 

If the application name already exists, a message box will appear.  Click OK to close the 
message box. 
 
You will have to click File > New Application… to launch the New/Open Machine Edition 
Application window again where you can enter a different name.  After a new name is 
entered, click Create. 
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4. Add the desired “PowerFlex_xxx_Faceplate.gfx” to your display. 

 

In the project tree view, under the Graphics folder, right-click on Displays and select Add 

Component Into Application… 
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5. The Add Component Into Project window will appear. 

 

Again, for your convenience, the PowerFlex Faceplate files were placed on the Desktop in a 

folder named “ME_PowerFlex_Faceplate_Files.”  Double-click the folder to open it up.  There 

will be another folder also named “ME_PowerFlex_Faceplate_Files.”  Again, double-click the 

folder to open it up.  In this lab, you are using a PowerFlex 700 VC drive.  Therefore, select the 

file in this folder named “PowerFlex_70_700_Faceplate.gfx” and then click Open. 
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6. Add the faceplate parameter file to your application. 

 

There’s a specific parameter file for every PowerFlex drive, just like a faceplate.  A parameter 

file links specific RSLogix 5000 project information that you created during the Integrated Drive 

Profile section to the FactoryTalk View Faceplate. 

 

In the project tree view, under the Graphics folder, right-click on Parameters and select Add 

Component Into Application… 
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7. The Add Components Into Project window will appear. 

 

The proper parameter file may already appear.  If it doesn’t, browse to the folder named 

“ME_PowerFlex_Faceplate_Files.”  Select the ME_PowerFlex_Parameter.par file and then click 

Open. 
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8. Open the parameter file (you just added) and edit the “tagname” to match your application. 

 

Remember when you assigned a name to the Integrated Drive Profile? 

 

For this lab, we named the PowerFlex 700 VC drive, My_PF700VC.  Therefore, change the 

default name “Motor_1” to “My_PF700VC.”  Be sure to scroll to the very bottom of the 

parameter file, note the lines that begin with a ‘!’ are for comments.  

 

Close the “ME_PowerFlex_Parameter” parameter file and click Yes to save changes. 
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9. Create an RSLinx Enterprise shortcut. 

 

In the project tree view, expand the RSLinx Enterprise folder and then double-click on 

Communication Setup. 

 

The RSLinx Enterprise Configuration Wizard will appear.  Select “Create a new configuration” 

and then click Finish. 
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10. Create an RSLinx Enterprise shortcut path to the network. 

 

The Communication Setup window will appear.  On the Design (Local) tab, expand the 

Ethernet driver and then expand the 1756-ENBT Ethernet bridge at IP address 192.168.1.7 to 

view its backplane.  Expand the backplane to display the 1756-L63 controller which presently 

holds the Integrated Drive Profile configuration and select it. 
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11. Click Add to display the “NEW SHORTCUT” in the Device Shortcuts window.  Rename the 

shortcut to “CLX-L63” to match the parameter file and then click on My_Controller in the I/O 

tree on the right hand pane, then click Apply. 

 

Please note that “CLX-L63” is used in the parameter file to associate tagnames to the 

appropriate controller. 

 

A message will appear confirming the update.  Click Yes to the message and then click OK to 

close the Communication Setup window. 
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12. Add the Goto_PowerFlex faceplate which contains the graphical images of the PowerFlex 

drives. 

 

The Goto_PowerFlex faceplates are also located in the ME_PowerFlex_Faceplate_Files folder 

and then in the ME_PowerFlex_GotoButtons folder.  Follow previous Steps 4 and 5 which 

showed you how to add a component to the FactoryTalk View project and import the 

Goto_PowerFlex.gfx file from the ME_PowerFlex_GotoButtons folder.  Then click Open. 
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13. After you click Open, FactoryTalk View will migrate the data and the Goto_PowerFlex entry will 

now appear under the Display section in the project tree view. 
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14. Add the PowerFlex drive images to the project. 

 

In the project tree view, right-click on Images under the Graphics folder and then select Add 

Component Into Application… to display the Add Component Into Project window. 

 

You will have to select two (2) images because the PowerFlex 700 faceplate is generic for both 

the PowerFlex 700 SC and VC drives.  Select the “01PowerFlex 700 VC.bmp” and 

“01PowerFlex 700.bmp” files (press-and-hold Ctrl and left mouse click each file) and then click 

Open to import the new graphics. 

 

 
 

If the “01PowerFlex 700 VC.bmp”  and “01PowerFlex 700.bmp” files already exist, when 

prompted click Yes to continue. 
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15. Create a Main display. 

 

After the Goto_PowerFlex display is imported, you will have to create a Main display that calls 

the PowerFlex 700 drive and its faceplate. 

 

Right-click on Displays under the Graphics folder and then select New.  A new “Untitled” 

window will display (right side of project window).  Double-click Goto_PowerFlex under the 

Displays section.  The Goto_PowerFlex window will also appear (right side of project window).  

Resize both windows so you can view both windows.  On the Goto_PowerFlex window, click on 

the image called “PF 700/700 VC” and “drag-and-drop” it on the “Untitled” window. 
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16. In the “Untitled” window, right-click on the “PF 700/700 VC” image and select Object Explorer.  

The Object Explorer window will appear.  Expand the PF700_700VC item and double-click 

GotoDisplayButton_PF700_700VC to display the Goto Display Button Properties screen. 

 

 

17. Once the Goto Display Button Properties screen appears, you will need to do two (2) tasks. 

 

Under Display settings, click the  by the Display field.  The Component Browser will appear.  

Select “PowerFlex_70_700_Faceplate” which will assign the PowerFlex 700 faceplate (added 

earlier) to the “PF 700/700 VC” image.  In other words, later on when you run the application 

and click on the image, it will launch its assigned faceplate which will be used for status and 

control of the drive on the network.  After the faceplate is selected, click OK. 
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18. Repeat Step 17 for the Parameter file section. 

 

Under Display settings, click the  by the Parameter file field.  The Component Browser will 

appear again.  Select “ME_PowerFlex_Parameter” which will assign the PowerFlex 700 

parameter file (modified earlier) to the “PF 700/700 VC” image and faceplate.  After the 

parameter file is selected, click OK. 

 

 

 

Then click OK to close the Goto Display Button Properties screen. 
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19. Close the Object Explorer window by clicking the “red X” in the top-right corner of the Object 

Explorer window. 

 

 

 

20. Close the “Untitled” window by clicking the “red X” icon in the top-right corner of the “Untitled” 

window. 

 

 

 

21. A message box will appear asking you if you would like to save changes.  Click Yes to display 

the Save screen.  When the Save screen appears, change the “Untitled” name in the 

Component name field to “Main” and then click OK. 
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22. The Main display should now appear under Displays in the project tree view. 

 

 

 

23. Configure the application to initialize on the Main screen when it’s in Run mode.   

 

In the project tree view, under the System folder, double-click Startup.  The Startup screen will 

appear. 

 

Click the box by the Initial graphic field to check it and then from the pull-down menu,  

select Main. 

 

Click OK.  
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24. Run the PowerFlex faceplate. 

 

To run the application, click the  (person running) icon at the top of the FactoryTalk View 

window. 

 

After about 20 seconds the PF700/PF700VC faceplate will appear.  If the Diagnostic Summary 

Window appears, click Close.  The initial alarm information displayed is expected and may not 

necessarily indicate a problem. 

 

 

ONLY type X if you want to stop the application.     
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Double click on the faceplate, PF700VC input screen appears.  To activate the window, 

Operator mode must be selected first, Click on Program to toggle to Operator mode. 
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25. Using the PowerFlex faceplate.        

             

Now all the buttons are active in the Faceplate.  You can Start, Stop, Jog, and change speed. 

            

       

  

To change speed, click on SPEED feedback.  
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Speed Reference is in Hertz, you can enter a value between 0-60hz.  After entering the speed 

on the keypad then depress the enter key,  
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You are now FINISHED with the Premier Integration Lab with Logix, 
PowerFlex Drives & FactoryTalk View.  The remaining part of the 

lab is optional. 
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Optional Lab Materials (Time Permitting) 

This section is optional, and for those that finish early and would like to learn more.  Please select any 

topic of interest: 

� Using Explicit Messaging – Learn how to use a MSG instruction to read and write data to the 

drive that is not already being communicated as part of the normal I/O update (implicit 

messaging). 

� Viewing the 20-COMM-E’s Web Pages – Learn about the web features of the 20-COMM-E 

EtherNet/IP adapter, including the ability to view diagnostic information, launch drive software 

tools, and send email messages. 

� Challenge! Conveyor Application - From the information learned, create a program using 

RSLogix 5000 that will simulate product (for example, bottles) moving on a conveyor line. 

� Using a non-AB Drive with ControlLogix – See what it takes for a competitor’s drive to connect 

to ControlLogix.  Information only – no hands-on lab. 
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Using Explicit Messaging (Optional) 

This section explains how to perform an explicit message to the PowerFlex 700 VC drive over an 

EtherNet/IP network.  Explicit Messaging is another method of reading / writing data from / to a drive for 

monitoring and configuring purposes.  They are similar to Datalinks, however, if Explicit Messages are 

programmed to write parameter data to Non-Volatile Storage (NVS) frequently, the NVS will quickly 

exceed its life cycle and cause the drive to malfunction.  Datalinks do not write to NVS and should be 

used instead for frequently changed parameters. 

In v15 (and higher) of RSLogix 5000, an easier method of performing an Explicit Message to a drive was 

added.  In the past, when you configured an explicit message, you had to figure out what Class, Instance, 

and Attribute to use, and then how to set up the information inside a Message (MSG) instruction.  Let’s try 

the new way! 

 

1. Go into the Main Routine again by double-clicking on MainRoutine. 
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2. If the controller is in Run mode, turn the controller key switch to PROG and then back to the REM 

position on the controller.  This will also put the controller into Rem Prog mode. 

 

If the controller is in Rem Run mode in RSLogix 5000, click on the mode pulldown box and select 

Program Mode. 

 

 

 

Confirm the change to Remote Program and click Yes. 
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3. Add a second rung (Rung 1) by pressing the Insert key on your keyboard or by clicking the Rung 

icon  from the top menu bar.  Then drag-and-drop an XIC instruction  and an MSG 

instruction  from the instruction bar (located in the Input/output tab).  When you are 

complete, Rung 1 should look similar to the picture below. 

 

 

4. Once the instructions are on Rung 1, you will have to create their individual tag properties.  Right-

click on the ? symbol of the XIC instruction, and select New Tag. 

 

 



 

91 of 108 

5. The XIC instruction will control when the MSG instruction will energize.  Since the XIC instruction 

is user-controlled, you may assign it any name you like.  For this example, we will name the XIC 

instruction “Enable_Read_Message”.  Also, since instructions like these are typical at the bit-

level, the Data Type field should be left at BOOL. 

 

 

 

When finished, click OK.  
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6. The MSG will store the configuration for the parameter that you will be reading data from.  Before 

you can configure the message, you need to give it a name.  Right-click on the “?” symbol inside 

the MSG instruction, and select New Tag. 
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7. For this example, we will name the MSG instruction “Read_Message”.  Also, since instructions 

like these are specifically for messaging, the Data Type field should be left at MESSAGE.  Verify 

the Scope field is set to My_Controller (controller scope). 

 

 

 

When finished, click OK. 
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8. Next, you need to configure the message instruction.  Do this by clicking on the  (3-dot button) 

inside the MSG instruction.  This will launch the Message Configuration screen. 

 

 



 

95 of 108 

9. This is the easier or more intuitive portion.  Simply click on the pull down menu under Service 

Type and select Parameter Read.  

 

 

 

Notice that the Service Code, Class, Attribute, Source Element, and Source Length automatically 

gray out for you.  No longer do you need to dig through a user manual and fill this information in.  

Faster configuration, less development time, and lower opportunities for mistakes! 
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10. All you have to do now is type in the parameter number that you want to read information from in 

the Instance box and then create a Destination tag where the parameter information will be 

stored. 

 

For this example, we are going to read Parameter 12 [DC Bus Voltage].  Therefore, in the 

Instance box, type 12. 

 

Next, you will have to create a tag that will represent parameter 12 and store its information.  

Click on New Tag, type in “DC_Bus_Voltage” in the Name box, set the Data Type to “DINT”, 

verify the Scope field is set to “My_Controller,” and then click OK. 
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11. You will have to assign the “DC_Bus_Voltage” tag (you just created) to the message.  Click on 

the Destination box pulldown, and select the “DC_Bus_Voltage” tag. 

 

 

12. The Configuration tab of the message is now complete.  Last, you will have to tell the message 

which device to look at in your I/O tree. Click on the Communication tab, and select Browse.  

For this example, it’s the “My_PF700 VC”.  Browse to the drive, click on the drive, and then click 

OK. 
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13. This will take you back to the Message Configuration screen again.  Click OK.   

If the controller is in Program mode, turn the controller key switch to RUN and then back to the 

REM position on the controller.  This will also put the controller into Rem Run mode. 

If the controller is in Rem Prog mode in RSLogix 5000, click on the mode pulldown box and select 

Run Mode.   

 

 

 

Confirm the change to Remote Run and click Yes. 

 

 

Click on the Finalize All Edits icon  and click Yes to finalize all edits in the program 
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14. When finished creating the rung and placing the controller back into Run mode, operate the 

explicit message by toggling the “Enable_Read_Message” instruction.  To toggle bit right click 

and select toggle bit.  To toggle off, do same procedure. 

 

 The MSG instruction should set its EN bit and then its DN bit if the explicit message was 

successful.  Re-toggle the “Enable_Read_Message” instruction again to reset the MSG 

instruction. 

 

If the ER bit is set, an error in the explicit message has occurred.  In this case, verify that the 

explicit messaging configuration information is correct.  Toggle the “Enable_Read_Message” 

instruction again, and verify that the MSG instruction set its EN bit and then its DN bit. 

 

Go into the Controller Tags folder, and verify a value range between “3000 - 3500” appears in the 

“DC_Bus_Voltage” tag.  This parameter is scaled for DC Bus Volts * 10.  So, you will need to 

divide the value you see by 10 (which gives you “300.0 – 350.0”).  Also, since the drive’s input 

voltage is 230/240 VAC, the DC equivalent would be approximately 300 - 350 VDC.  If you are 

still having trouble, please call over an instructor. 

 

Repeat Steps 3 through 15 for an explicit message Write that will write information to  

Parameter 141 [Accel Time 2].  When you are finished, you may show your instructor.  If you 

are having trouble getting started, please ask an instructor for assistance. 
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Viewing the 20-COMM-E’s Web Pages (Optional) 

This section provides instruction on how to use Internet Explorer (or a similar internet browser tool) to 

monitor the adapter and connected PowerFlex 700 VC drive using the 20-COMM-E adapter’s web pages. 

 

1. Close RSLogix 5000 without saving your program. 

2. Double-click on the Internet Explorer icon on the desktop, or Start> Programs> 

Internet Explorer  With Internet Explorer launched, type the IP address (192.168.1.8) for the 

PowerFlex 700 VC drive / 20-COMM-E adapter (not the 1756-ENBT module) following the 

“http://” command on the address bar.  For example, http://192.168.1.8/.  When connected, the 

left tool bar (which is in Window’s Folder View) is very intuitive and easy to understand.  Take 

your time and begin to familiarize yourself with the built-in web features including email 

notification, diagnostics, and the ability to directly launch drive software tools. 
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Challenge!  “Conveyor Application” (Optional) 

From the information learned, create a program using RSLogix 5000 that will simulate product (for 

example, bottles) moving on a conveyor line.  In order to be successful, the drive must perform the 

following steps in order: 

 

� Start 

� Ramp up to 30 Hz and continue to run for 5 seconds 

� Then ramp up to 60 Hz and continue to run for 30 seconds 

� Slowly ramp down to 0 Hz 

� Stop for 10 seconds 

� (Bottles are at destination) 

� Start 

� Ramp up again to 60 Hz and continue to run 

 

Call over an instructor to approve your design. 



 

102 of 108 

Using a Non-AB Drive with ControlLogix (Optional) 

This section shows an example of the extra work that must be performed when a non-AB drive is used 

with the ControlLogix controller. 

 

1. Using the generic profile. 

 

All competitor drives can connect to the ControlLogix via the Generic Profile.  This requires 

looking up the desired input and output assembly instances that are available for the drive and 

the lengths for each. 

 

 

 

In the picture above, input assembly instance “155” for this competitor drive contains status bits, 

feedback, output current, DC bus voltage, and several more parameters.  The format is fixed, with 

each piece of data in a specific location within the 20 word block of inputs.  The output assembly 

instance “101” for this competitor drive contains control bits and reference.  There was no 

assembly to handle common parameters, such as Accel Time and Decel Time.  If your controller 

application needed to adjust these, then they would have to be read via a MSG instruction 

(explicit messaging), which is more work and time for the programmer. 

PowerFlex AOPs allow the programmer to design the network I/O image they want.  
There are no “fixed” I/O assemblies and programmers can directly select the parameters 
they want to access as part of the network I/O. 
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2. Working with non-descriptive tags. 

 

The Generic profile creates a ‘blob’ of non-descriptive tag names.  These generic tag names are 

meaningless without tag descriptions.  

 

 

 

The picture above illustrates a SINGLE drive connection using a small amount of I/O.  Although 

only 4 words of inputs (status, feedback, and two parameters) and 4 words of outputs (control, 

reference, and two parameters), it results in 38 tags descriptions that have to be added.  In 

Method #1, this is done manually by the user.  This takes considerably more time for the 

programmer, especially if multiple drives are being used in the application. 

PowerFlex AOPs automatically generate descriptive names for all tags. No additional 
work is necessary. 
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3. Using user-defined data types (UDT’s). 

 

Knowledgeable programmers will create a UDT so they can create descriptive tag names and 

only have to do them once.  However, two COP (Copy) instructions are required (one for inputs 

and one for outputs) for every drive, and they move the non-descriptive tags (the ‘blob’) over to 

descriptive tags. 

 

 

 

There are some negatives with this method: 

� The programmer still has to take the time to manually create the UDT. 

� If a particular drive in the application needs a different I/O assembly instance, then 

another UDT will have to be created.  A UDT will be needed for every I/O assembly 

instance used (more programming time). 

� The programmer has to program (2) COP instructions for every drive (more programming 

time).  A 25 drive application will need 50 COP instructions.  Again, more programming 

time is required. 

PowerFlex AOPs automatically generate descriptive names for all tags. No additional 
work is necessary. 
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4. Drive-side configuration using a separate software tool. 

 

The competitive drive still needs to be configured and is typically accomplished using one of the 

competitor’s software tools. 

 

 

 

Many drive competitors offer only a serial connection and some offer serial and Ethernet.  This 

typically takes extra time and effort to set the drive up separately from the RSLogix 5000 

program. 

 

he drive configuration also gets saved in a separate file that has to be kept with other files for the 

project (other drive files, RSLogix 5000 .ACD file, etc.).  Typically the files get saved to a floppy, a 

server, or someone’s hard drive and at 2AM when a drive fails and needs replacing, no one is 

certain where the master copy is located (and if it is current). 

PowerFlex AOPs contain the functionality to configure the drives.  A separate software 
tool is not required.  The PowerFlex drive configuration is saved in the .ACD file and is 
also stored in the controller (SINGLE resource location) when the .ACD is downloaded. 
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5. Using explicit messaging. 
 
If certain desired parameters for the application can not be accessed as part of the normal 
network I/O (implicit messaging), then explicit messaging is required. 
 

 
 
The above picture illustrates a competitor that can not write the Accel Time and Decel Time 
parameters in the network I/O update.  In this example, two MSG instructions have to be 
programmed to perform this function for a SINGLE drive (more programming time).  A 25 drive 
application will need 50 MSG instructions.  Again, more programming time is required. 

PowerFlex drives use Datalinks which are configured using our AOPs and are part of the 
network I/O image.  Up to eight parameters can be read (inputs) and up to eight 
parameters can be written (outputs).  There is no “fixed” I/O assembly and programmers 
can choose the parameters they want. 
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6. Summary 

 

PowerFlex Add-On Profiles reduce the amount of programming time and effort required, enabling 

systems to be developed faster.  The auto-generation of descriptive tags and the SINGLE 

location for Logix programming and PowerFlex configuration, reduce programming errors and 

allow for faster start-ups.  Since drive configuration data is stored in the RSLogix 5000 .ACD file 

(SINGLE file) and also stored in the controller (SINGLE resource location) when the .ACD is 

downloaded, systems are easier to maintain. 

 

 

 

If you were the programmer, which drive would you choose? 
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Notes 

 


